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Abstract

XPENELOPE provides a user-friendly X window environment
for PENELOPE. It supports the tasks of model creation, speci-
fication and control of series of experiments, and visualization of
the results.

PENELOPE provides numerical and simulative methods based on
the theory of Markov decision processes that are applicable for
the optimization of performability measures. The optimization
paradigm is based on the concept reconfigurabilitpnsientas

well as stationary control strategieand performance functions
can be computed.
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1 Introduction

PENELOPE is a software tool for the “dendability evaluation and theoptimization of
performability”. PENELOPE is based on the theory ettended Markov reward models
[DEME 92]. The primary task of PENELOPE is the optimization of performabiligasures.
The user may interact with PENELOPE either through a graphical user icgesfathrough a
command line interpreter.

1.1 Extended Markov Reward Models

Let 7 = {Z(¢),t > 0} denote a continuous time Markov chain with finite state sygc&o
each state € S a real-valuedeward rater(s), r : S — IR, is assigned, such that if the Markov
chain is in stateZ (¢) € S at timet, then theinstantaneous reward ratef the Markov chain at
timet is defined as{(¢) = r(,. Inthe time horizor0, ...t) thetotal rewardY () = [; X(7)dr
isaccumulated. Note thaf(¢) andY (¢) depend or¥ (¢) and on an initial state. The distribution
functionU(y,t) = P(Y(t) < y) is called theperformability A Markov chainZ, for which a
reward function- has been defined, is calledviarkov reward modelFor ergodic models the
instantaneous reward rate and the time averaged total reward convéngdimit to the same
overall reward ratém;, .., E[X(t)] = lim,,., 1E[Y ()] = E[X].

t

For each unit of time in which the system is in a certain state, the @unelsng number of
reward unitsX (¢) is added to the total rewarf§ X (r)dr. Thus, it is possible to define a “yield
measure” or a “loss measure” for the system by using appropriate reward rates

Extended Markov reward modelEMRMS) enrich Markov reward models by the feature of
reconfiguration edgedVhenever the system is in a state in which a reconfiguration edge origi-
nates, a decision must be made whether or not to switch to the target statesafdhiguration
edge. The optimal decision may be time dependent. Additionally, the Markov renard
dels are extended by so-callbthnching statesThese are states in which the system does not
spend any time. With the help of branching states, it is possible to assignd&alues to state
transitions (so-calledulse reward}s

EMRMs were derived in order to provide an abstraction from Markov dectsieory. EMRMs
are a marriage between performability modeling techniques and Markovaretigory and
provide a general framework for the dynamic optimizationemionfigurable, dependable sys-
tems.

1.2 Features of PENELOPE

Reconfiguration edges denote options to reconfigure from one state to another. At eleerty ins
of time a different decision is possible for each reconfiguration edge. Agyréte) comprises
the set of all possible decisions at a particular instant of timie < ¢ < T'. Strategies can
be time dependent or stationary. In the latter case the paramedarbe droppeds = S(t).

A strategyS(t) is consideredptimalif the performance of the system under stratégy) is
better or equals than the performance of the system under any other st¥ategy

1



PENELOPE offers two types of methods for the computatioopifmal strategiesand per-
formance functions

¢ Transient Optimization:
The system is investigated for a finite period of time, the so-catiesion timel’. Op-
timal strategiesS(¢) are computed for every instant of timg0 < ¢ < 7. The results
are depicted a§(t'), which is a function of theemaining time ¢/, ¢’ = T' — ¢, wheret
denotes thelapsedtime. In addition, the expected accumulated rew[¥;(¢)] is also
computed forll initial states;, provided the optimal strategies were applied.

¢ Stationary Optimization:
The optimization is performed for an infinite time horizon. A strate@yis op-
timal if no other strategyS exists such that the time averaged mean total reward
E[X;] = limy_., 7 E[Y;(?)] gained under strategy exceeds the one gained under
FE[X;] can be dependent or independent of statk the latter casdé/[X]| = FE[X;] for
all 7, is called the (optimal) overall reward rate. The optimizationfiiseperformed by
the deployment of standard methods from Markov decision theoryM[86]. The adap-
tation of these methods to the analysis of EMRMs is out of the scope of this reference
manual. More details can be found in 4Kk 92].

In addition, PENELOPE offers procedures for computations ufigded deliberately eligible
strategies

e Simulation
Under a fixed strategy, the behavior of the system is simulated. The meancttada
lated reward for an arbitrary initial state is computed.

e Transient Analysis
The transient analysis is carried out under a fixed strategy that can be d&ipepeci-
fied. The strategy can be either of a transient or a stationary type.

e Stationary Analysis
The stationary analysis is carried out under a fixed strategy. The strategnty be of a
stationary type.

PENELOPE offers two possibilities for the user to interact with theesygst

e The extended Markov reward models are defined by using a model description language.
These models can be analyzed and optimized by invoking appropriate commands from
the PENELOPE command line interpreter. The computed strategies areeckiara
textual format with a clearly defined syntax. This enables automated pregpiragesnd
postprocessing of model/strategy data.

¢ Using the graphical user interface XPenelopas 93], the models are created inter-
actively. Inthis case, the user is working with familiar symbols suatirakes (for states)
and arrows (for state transitions).



Additionally, the graphical user interface offers a lot of extra functionality:

1.3

Automated execution of experiment series.
Graphical preparation of experiment results.
Automated checking of model consistency.

Definition and evaluation of hierarchical and iterative models, using aap®&acro
mechanism.

Definition of model parameters and an arbitrary number of parameter set®gdel.m
Preparation of computed strategies.
Operating system independent data management:

— model data base
— parameter set data base
— experiment and results data base

strategy data base

Printing of models and results for documentation purposes.

Platforms

XPENELOPE runs under the following architectures:

Sun 4 with SunOS 4
Sun 4 with SunOS 5 (Solaris)

XPENELOPE requires an existence of the X Window System release 11 vérgiphigher
and of the OSF/Motif GUI system version 1.1 or higher.

2 XPenelope User Guide

2.1

Invocation

XPenelope is invoked by executing the command

xpenelope



from the command line. This will bring up the model index (see section 2.2).

If xpenelope is called for the first time, the model database will be created and san@esa
models will be copied into the user’s database. Normally, the location for tiieldatabase is
the directory

$HOME/.xpenelope

This may be overridden by setting the environment varigl&lELOPEDB the desired path
name.

2.2 The Model Index

A-Example
A-Example-hak
A-Mak-a <M=
A-Mak-h <=
Af-hakro <h=
Af-Test <M=
Eeispiel
EetterRouting
Eighdodel
Connect <h=
Drehbank

f

Create | Copy | Rename | Delete | Open | Print | Cluit |

Figure 1: Model index.

The model index is a list of all predefined models and macros (see Fig. 1). Maerosmeked
with the suffix “<M>". One of the following buttons may be pressed:

Create Creates a new model. The model editor is opened (see Sec. 2.5).

Copy {Makes a copy of the selected model. Type in the desired model name in response
to the prompt “Name of copy:”, and pre€K. Then the whole model together
with its parameter sets, experiment definitions and results of experinréesg,send
strategies is copied.

Rename {Renames a model. Type in the desired model name in response to the prompt “New
model name:”, and pre3K.

Delete jDeletes a model together with its parameter sets, experiment definitionssaris
of experiment series, and strategies.

Open  {Brings up a pull-down menu, which offers the following choices:

Model Editor... Opens the model editor (see Sec. 2.5).

Parameter Index... Shows/Edits the list of all parameter sets defined for the
model (see Sec. 2.3).
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Experiment Index... Shows/Edits the list of all experiment definitions (see
Sec. 2.4).

Print TPrints the model as a PostScript file. A dialog with the following choices appea

Send to printer: Sends the PostScript file to the indicated printer.
Send to file: Stores the PostScript graphics in the specified file.

Quit Quits the program.

All operations marked with require that a model (or a macro) has been previously selected
from the list.

A double-clicking of a list item performs th@pen— Model Editor... action.

2.3 The Parameter Set Index

4-Knoten-Gamma-Var.
Svail.-c,gamma-vyar.
Svailability- Gamma-"ar.
Availability-Gamma-less
Availability-delta-0.001
Availability-delta-0.1
CO8—-compare-performance
COA-gamma-less
Capacity-ariented- Ay,
Konstant

|Createl Copy Copy To| Rename|  Delete Cpen Cancel

Figure 2: Parameter set index.

The parameter set index (see Fig. 2) is a list of all parameter setaldeaior the selected
model. One of the following buttons may be selected:
Create Creates a new parameter set. The parameter set editor is opened (s26)Sec

Copy {Makes a copy of the selected parameter set. Type in the desired parashatens
in response to the prompt “Name of copy:” and then pf@Ks

Copy To tMakes a copy of the selected parameter set to an arbitrary model. Type in the
desired parameter set name in response to the prompt “Name of copy:” and then
pressOK. Then the name of the model is prompted for.

Rename {Renames a parameter set. Type in the desired parameter set name ingéspons
the prompt “New parameter set name:” and then p@dss

Delete {Deletes the selected parameter set.

5



Open

Cancel Leaves the parameter set index.

T1Opens the parameter set editor (see Sec. 2.6) for the selected paramneter s

All operations marked with require that a parameter set has been previously selected from the

list.

A double-clicking of a list item will perform th©pen action.

2.4 The Experiment Index

Avail.-gamma-less
availability
CiO8—-compare-performance
Capacity-gamma-less
Capacity-or.- Avail
Impact_of_Cov._avail.
Impact_of_Cov_Avail.- stationary
sana

sana-test
sim-1000tu-ar-M1
sim-1000tu-nr-M4

| Create I Copy

Rename

Copy To

£

Delete Cancel

Qpen

Figure 3: Experiment index.

The experiment index (see Fig. 3) is a list of all experiments available foseleeted model.

One of the following buttons may be selected:

Create Creates a new experiment. A name of the new experiment is asked for. Then the
experiment editor is opened (see Sec. 2.7).

Copy

TMakes a copy of the selected experiment. Type in the desired experiment name

in response to the prompt “Name of copy:” and then p@Ks Then copies of the
experiment definition and of the results of this experiment are made.

Copy To tMakes a copy of the selected experiment to an arbitrary model. Type in thedlesir
experiment name in response to the prompt “Name of copy:” and then @¥ess
Then a name of the model is asked for.

Rename fRenames an experiment. Type in the desired experiment name in response to the
prompt “New experiment name:” and then prexs.

Delete fjDeletes the selected experiment.
Open
Cancel Exits the experiment index.

TOpens the experiment editor (see Sec. 2.7) for the selected experiment.



All operations marked with require that an experiment has been previously selected from the
list.

A double-clicking of a list item will perform th©pen action.

2.5 The Model Editor

Options
Markoy State
Branch State

Transition

Reconfiguration Edge

hacro Terminator
hacro

Set Parameters
Delete

Figure 4: Model editor.

The model editor (see Fig. 4) is a “canvas” on which state-transition diegcan be rendered.
The following symbolism is used within the model editor:

| Object | Representation|
Markov State Q
Branching State .
Transition —_—
Reconfiguration Edge  -------= >

Macro Terminator

U W
Macro ™
Missing Parameters @
Inconsistent Macro [

The arrows inside the macro symbols are called “sockets”. They point inwatard), if the
attached transition or reconfiguration edge is entering (leaving) the macro.
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The menu bar of the model editor offers four choices:

File Loading, saving, and printing models.

Edit Creating, modifying, and deleting objects.

Options Grid and node name operations.

Help Currently, only the menu iterilelp on Version is offered. It displays the version

number of the program.

The following sections discuss the individual menus.

2.5.1 The File Menu

New... Creates a new model.
Open... Loads a new model that is selected from the model index.

Save Saves the model. If the model has been previously saved, the same file name will
be used. Otherwise, a file name is asked for.

Save As...Saves the model under a new file name. The file name is asked for.

Print...  Prints the model as a Postscript file. Options are available to save tbethlsend
it directly to a printer.

Exit Leaves the model editor.

2.5.2 The Edit Menu

The first eight choices of the edit menu determine which action is performed [eft mouse
button is pressed (the “select button”) within the model editor. A indicatah¢oleft of the
menu items shows which item currently is enabled.

Markov State Activates the Markov state mode. In this mode, a new Markov state is
created if the select button is pressed.

Branch State Activates the branch state mode. In this mode, a new branching state is
created if the select button is pressed.

Transition Activates the transition mode. In this mode, the following steps have to
be performed in order to create a transition:

1. Click at the start node.



2. If no intermediate vertex is needed, goto step 3, otherwise click
anywhere in the canvas (except over other objects) in order to cre-
ate a new vertex. Repeat this step until all intermediate vertices
have been created.

3. Click at the target node. Now the transition will be displayed.

Reconfiguration Edge Activates the reconfiguration edge mode. In this mode, an equivalent

Macro Terminator

Macro

procedure as in the transition mode is used in order to create a reconfi-
guration edge.

Activates the macro terminator mode. In this mode, a new macro termi-
nator is created if the select button is pressed. Models containing macro
terminators are called “macros”; a macro terminator is the connection
of the inside world of the macro to the outside world. If a macro is
invoked by using théMacro item of theEdit menu, the macro termi-
nators will be shown as little arrows (“sockets”) within a larger feam
The direction of an arrow indicates the direction of the transition which
is attached to the corresponding terminator.

Activates the macro mode. In this mode, a new macro invocation is
created if the select button is pressed.

Af-hakro

Af-Test

Connect

Erlang

Erlanghdak.
Kap4.2-Makro
Kapd.2-Makro-LastCase

kacro Mame:

It

Ok | Forward...l Cancell

Figure 5: “Macros” dialog box.

Having theMacro menu item selected, the “Macros” dialog box pops
up (see Fig. 5). It contains a list of available macros; select one of the
list items and then pre$3K. PressCancelif the operation should be
aborted.

If a recursive macro definition is to be created a macro which has not
yet been defined has to be used. Hoeward... button can be selected
in order to create a macro forward declaration (see Sec. 2.5.5).

If a macro invocation and a macro definition don’t match, the macro
invocation will be displayed as a crossed-out box. In this case, the in-
consistent macro invocation must be deleted and a new consistent invo-
cation has to be created.

9



Set Parameters

Activates the parameter modification mode. In this mode, any object
may be selected in order to modify its parameters. (This does not apply
to reconfiguration edges, which are parameterless.) If an object has
been newly created, a question marR’{"is displayed on top of the
object; this indicates that there are still parameters to be set.

[®] Parameters...

MName:

Reward: i

| Cancell

Figure 6: “Parameters” dialog.

If an object is selected a dialog box will appear allowing to change the
object parameters (see Fig. 6). TDK button must be pressed in order

to apply the new parameters to the object. No changes are made if the
Cancelbutton is pressed.

e A Markov state or a branching state has the following parameters:

Name: Name of state. A state name must start with a letter
and may contain any of the characters A...Z, a...z,
0...9,, (), [and].
Reward: Reward rate; any arithmetic expression may be en-
tered in this field (see Sec. 2.5.4).
¢ A transition has one of the following parameters:
Rate: State transition rate (applies only to transitions
originating in a Markov state).
Probability: Probability of the transition (applies only to tran-
sitions originating in a branching state).
Any arithmetic expression may be entered.
e A macro terminator has the following parameters:
Name: Name of the terminator.
¢ A macro invocation has the following parameters (see Fig. 7):

Name: Name of the macro invocation.

Class: Class of the invoked macro; this is the model name
assigned to the macro definition.

Condition:  Any arithmetic expression. If the expression is
zero, the macro invocation will be ignored. Other-
wise, the macro invocation will be substituted by
its definition (at experiment execution time). This
field is initialized with1.0.

Parameters: A list of all parameters that appears in the macro
definition. Each parameter may be substituted by

10



Class: IEErIang

Mame: I d

chdmon:Iﬁ

Iambda:lﬁambda

N:I@

rew: I ew

%I Cancell

Figure 7: Macro parameters dialog.

an arithmetic expression; the substitution is per-
formed at experiment execution time. Initially,
each parameter is substituted by itself.

The names of all states, terminators, and macro invocations in a model
must be unique.

Delete Activates the delete mode. In this mode, the select button may be
pressed over an object in order to delete it.

Clear Erases the whole model.

2.5.3 The Options Menu

The options menu consists of five toggle buttons:

Show Grid Makes the grid visible/invisible.

Snap to Grid Activates/deactivates grid-snap mode. In this mode, all newly credited
jects will be centered with respect to the nearest intersection of ithe gr

Show Node NamesShows/Hides the names of states and terminators.
Show Node RewardsShows/Hides the reward values of states.

Show Transition Rates Shows/Hides the rates of transitions.

2.5.4 Arithmetic Expressions

An arithmetic expression consists of numbers, parameter names, openatbisnetion calls.
The operators obey the usual precedence rules for arithmetic operators:

11



| Operator | Precedence] Meaning

- 1 (highest) | unary minus

B 2 exponentiation

* 3 multiplication

/ 3 division

+ 4 addition

- 4 subtraction

< 5 less-than comparison

> 5 greater-than comparison

<= 5 less-than-or-equal comparison
>= 5 greater-than-or-equal comparispn
= 5 test for equality

<> 5 (lowest) | test for inequality

Parentheses may be used to override the default precedence rules.

If the comparison succeeds the comparison operators on precedence level b.oaithrarwise
they return0.0. The comparison operators are generally only useful in the “Condition” field of
the “Macro” dialog box.

The following functions are defined:

| Function | Meaning |
SQRT() | square rooti/x

EXP(X) power to the base: ¢*
LN(x) natural logarithmin «

A number is a sequence of digits with an optional embedded decimal point. An exponent suffix
may be appended, i.e., the letégran optional sign, and a sequence of digits.

Examples:

3
3.14
0.0314e2
314e-2

A parameter is a sequence of characters starting with a letter; theg@@aname may contain
letters, digits and underscores’: The actual value of a parameter is defined in the parameter
set editor (see Sec. 2.6).

Examples:

(14 x)? (1 +x)"3
2. 2 *a* EXP (1X)
Vi SQRT ((1+X)/(1-X))

12



2.5.5 The Forward Declaration Dialog

Class: | Examplg

Socket names: FParameters:

Inputt # In alpha
Inputz # In heta
Cutput? 7 Out
Cutputz 7 Out

Socket name: I Parameter name: II

W In 4 out
Insert | Delete | | Insert I Delete |
%I Cancell

Figure 8: “Forward Declaration” dialog.

The purpose of the forward declaration dialog (see Fig. 8) is to declare a mhmio has not
yet been defined. The following information has to be provided:
Class The name of the model that will contain the macro definition.

Socket names The names of the macro terminators. Use the buttisart to insert new
socket names and the butt@eleteto delete the selected socket names.
The radio buttonth andOut determine the direction of the socket.

Parameters The names of the macro parameters. Use the butisert to insert new
parameter names and the buttdelete to delete the selected parameter
names.

Press theOK button in order to create the forward declaration, or p@ascelto abort the
operation.

2.6 The Parameter Set Editor

The parameter set editor (see Fig. 9) is used to assign concrete valhesnmmdel parame-
ters. Each parameter may have one or more values. For all possible valuenabams one
experiment will be executed.

The numbers entered in the parameter set editor consist of digits, an optionaldsdlakeci-
mal point, and an optional exponent suffix. For example, Botd and0.314e2 are valid
numbers.

Each number is rounded to twenty digits: 1e-21 = 0.

Select a parameter from the parameter index and activate one of the fgloadio buttons:

13



Parameter: | gamma

Yalues: |00
Walue Range: <+ 1 Walue 0.0z

0.05
< M Equidistant Yalues

4 M Arbitrary Values

< M Log. Equidistant Yalues

Savel Cancell

Figure 9: Parameter set editor.

1 Value There is exactly one value for this parameter (fiddue).
N Equidistant Values The values for this parameter are taken from the set
{zlr=a+s-4, 1=0...N -1}

whereq is the value from the fiel&tart Value, s from the fieldStep
Width and N from the fieldNumber of Steps

N Arbitrary Values The values are taken from the fieldlues This field can hold an arbi-
trary number of values. Each number must be in a separate line.

N Logarithmic Equidistant Values The values for this parameter are taken from the set
{zlz=a-f', i=0...N -1}

whereq is the value from the fiel&tart Value, f from the fieldFactor
and N from the fieldNumber of Steps

Press the&savebutton in order to save the parameter set, or p@zswcelto exit the parameter
set editor.

2.7 The Experiment Editor

The experiment editor (see Fig. 10) is used to create experiment definitions,drperiments,
to save experiment definitions and results, to display results, and to@aited strategies.

An experiment definition requires the following information:

14



Parameter Set

Mode

Mission Time

Strategy

Step Width

Mocel: |Hprocessors

Parameter Set

Availahility-Gamma- var. |

Mode: <> Transient Optimization

< Transient Analysis

< Stationary Optimization

< Stationary Analysis

< Simulation

| Strategy Index I

Save Strategy

Step Width: |01 s

Taylor Degree: < 0 1 w2 <3 o

Info: 1 Model I Structure Analysis I Trace [ wsne

Save Save As Run | o | [ show Cancel

Figure 10: Experiment editor.

Available Parameter Sets:

Routing-24ar

Routin—Const

Farameter Set:

I Routing- &
Ok | Cancell

Figure 11: “Parameter Sets” dialog.

The name of the associated parameter set. Press this button in order to
display the “Parameter Sets” dialog (see Fig. 11). One of the available pa-
rameter sets may be selected. P@&sto return to the experiment editor.

One of the modeS$ransient Optimization, Stationary Optimization, Si-
mulation, Transient Analysis, or Stationary Analysis can be selected.

A mission time must be specified for the transient optimization, transient
analysis, and for the simulation.

A fixed strategy may be specified for the transient and stationary analysis
and for the simulation. It can be loaded in the Strategy Index (see Sec. 2.8
— Load). The strategy is considered as<ad strategy for this experiment,

no optimization will be performed.

The step width for the transient optimization and the transient analysis de-
termining the accuracy can be specified.

15



Taylor Degree

Start State

The values 0, 1, 2 or 3 are possible. The default Taylor degreeis 1.

The start state of the simulation.

Number of Runs The number of runs for the simulation.

Iteration Mode Strategy Iteration or Value Iteration may be selected for the stationary

optimization.

Absorbing States Click at this button if the model contains absorbing states for the appro-

Iterations
Value lter. Eps.
Method

Method lter.

Epsilon

Omega

Max. difference

Info

priate computation method to be performed for the stationary optimization
and stationary analysis.

Number of iterations to be performed.
Termination criterion for Value Iteration. Defaultt)—>.

Available methods for the solution of linear equatiorGauss Power,
Gauss-Seidelor SOR.

Number of iterations for the iterative methods (Power, Gauss-Seidel).SOR

Termination criterion for iterative methods for the solution of linear equa-
tions. Default:1075.

Relaxation parameter for SOR method. Default: 1.2.

In the strategy iteration, two valuesandb are considered as equal if
la — b| < d, whered is the value of theMax. difference field. Default:
1075,

The toggle buttorModel determines whether the info file should contain
the model description or not.

The toggle buttorstructure Analysis determines whether a structure ana-
lysis of the model should be provided or not.

If the toggle buttonTrace is on a trace of the computation is provided for
the given time steps. Defaul?0. In the menuWhat, one can specify the
tracing states to be traced.

Meaning of the buttons:

Save Strategy

Strategy Index

Load Results

Save

This button may be pressed if the experiment was run in the former and
computed strategies exist. A strategy name is asked for.

Shows/Edits the list of all strategies saved for this model (see Sec. 2.8)

If the results of the experiment were previously saved they can be loaded
(resp. reloaded) from the experiment database by clicking at this button.

Saves the experiment definition, and the results of this experiment if there
are any.
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Warking...

I

Ahort |

Figure 12: “Working...” dialog.

Save As Saves the experiment definition, and the results of this experiment if there
are any under a new name. The experiment name is asked for.

Run Starts the experiment. While the experiment is performed, a “Working...”
dialog appears (see Fig. 12). The experiment may be aborted with the
Abort button of the “Working...” dialog.

PENELOFE, Version 1.5 —--—-
oad “/usr/tnp/dasati2Bee’ ...

271,00
30,51 N2 ,..,0]
HE ...01

ewards computed in a tine horizon [0,999,3)

B40,907 Cov2; EEE,219 Cov3: EB80.867 Mog 078,930

1,59 N2 BBG,02  N3: 681,55 Nd: 630,202

: 641,59 RS BG6.902  Rdr 681,55 BBl 635,324
s EE0.E36  REZ: 670,284 RCL: BE40.963  RC2: EEE,ZVD
680,923

Figure 13: “Info” window.

Info Shows information on the performed experiment (see Fig. 13). The Info
file contains:

Parameter combinations.

TModel (in PENELOPE'’s model description language).

TStructure analysis of the model.

TOutput of the trace function on defined states.

Optimal strategies.

Accumulated rewards.

State probabilities.

e Error messages of PENELOPE.

All informations marked with require that the corresponding Info toggle
button is set on (see bellow).
The Info is displayed using the UNIKss program.
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Show Shows the results of the experiment. The “Graph Parameters” dialog pops
up (see Sec. 2.9).

Cancel Leaves the experiment editor.

2.8 The Strategy Index

Svail-stationary
Avail.-always-reconfigure
Avail.-never-reconfigure
Availability
Svailability-DBE
Svailability-DBE-war.par.

Create Load Copy | Copy To| Rename| | Delete Open | | Cancel

Figure 14: Strategy index.

The strategy index (see Fig. 14) is a list of all strategies availabldnéselected model. One
of the following buttons may be pressed:

Create Creates a new strategy. A new strategy name is asked for. Then thg\seditor
is opened (see Sec. 2.8.1).

Load TLoads the selected strategy in the experiment definition. The name of the loaded
strategy appears in the experiment editor. If the selected strategy igarisent
type the mission time of this strategy appears in the widget “Mission Timé¢fie
experiment editor.

Copy {Makes a copy of the selected strategy. A name of the copy is asked for.

Copy To {Makes a copy of the selected strategy to an arbitrary model. Type in thedesir
strategy name in response to the prompt “Name of copy:” and then @kes$hen
a name of the model is asked for.

Rename Renames a selected strategy. Type in the desired strategy hame in esgpthres
prompt “New strategy name:”, and then pré3s.

Delete f{Deletes the selected strategy.
Open  1Opens the strategy editor for the selected strategy (see Sec. 2.8.1).

Cancel Exits the strategy index.

All operations marked with require that a strategy has been previously selected from the list.

A double-clicking of a list item will perform th©pen action.
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2.8.1 The Strategy Editor

4 Transient Strateqy < Stationary Strategy

Mission time: [H oo

FParameter: Strateqy:

gamma: 0.01 N1 RZ AT N L0
gamma: 0.001 MZ :R3 .129.4] N2 0]
gamma: 0.0013 M3 ;R4 TE0.9] N3 0]
gamma: 0.002

gamma: 0.005

gamma: 0.0002

gamma: 0.0007
gamma: 0.0005
gamma: Ge-05
gamma: 0.0001

+ Mew Parameter Combination <+ Mew Parameter

I IEgamma e IEU.DUDB ¥ [ox]
Strategy for all combinations: I OK|
Save Save As | Wiew Cancel |

Figure 15: Strategy editor.

The strategy editor (see Fig. 15) is used to create, modify, and displésgsts

It contains:

e Toggle buttonsransient Strategy and Stationary Strategy which determine a type of
the selected strategy.

e Mission time. The mission time is used only for transient strategies.

e Alist of Parametercombinations. Each combination is represented by names and values
of the varying parameters. Both, name and value, can be modified in the text widget
NameandValue. By clicking at theup arrow (resp.down arrow), the previous (resp.
next) parameter of the selected parameter combination appears. The @Kttoext to
the arrows must be pressed in order to apply the parameter modification to dinesper
combination list.

To create a new parameter of the selected combination click at the toggbe blew
Parameter, write a name, and a value and then press OK.

To create a new combination click at the toggle butiew Parameter Combination
write a name, and a value of the first parameter in the new combination and &= pr
OK. New combination is created. The remaining parameters of this combirzatiohe
put in by clicking atNew Parameter.
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e Strategy. This text widget contains a strategy of the selected parameter combinatdion. F
the syntax see [Mus 90]. Both, transient and stationary syntax, are valid. The strategies
can be modified by the user. Each line must be terminated with new line akraract

In the text widgetStrategy for all combinations, write a line that is equal for all para-
meter combinations. By pressing the but®K next to this text widget, strategies for all
parameter combinations are modified in the line with the same reconfiguraiten st

Meaning of the buttons:

Save  Saves the strategy editor.
Save As Saves the strategy editor under a new name. The strategy name is asked for.
View Shows the current strategy. The “Graph Parameters” dialog pops up (se&%ec.

Cancel Leaves the strategy editor.

2.9 The Graph Parameters Dialog

B T

4 Strategy Graph Expeniment Name: | qijailiy

Performance Gragh
e i <Strategy>
<Tine>

OK Forward Change Cancel

Figure 16: “Graph Parameters” dialog.

[#] Values [#] Difference values [®] which

A B Covl B
= 5e-05
| |0.0001
[ |0.0002
t |0.0005
[ |0.0008
| |0.0007
| |0.0008
™ |0.001

fe-05
0.0001
0.0002
0.0005
0.0006
0.0007
0.0008
0.001

% || Cove
[ i|cova

Figure 17: “Value”, “Difference Values” and “Which rewards” dialogs.

XPenelope uses 2D-plot programs to display the results of the experiments. ThasZeA
the graph parameters dialog (see Fig. 16) represents the capability to plipledita sets per
graph.

Select a kind of graph by clicking at one of toggle buttons:
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Strategy Graph The three lists “X-Axis”, “Y-Axis” and “Z-Axis” contain the possible axis
labels “<Time>", “ <Strategy-" and names of the parameters with more than one
value.

Performance Graph By selecting the toggle buttgoositive the values of reward rates will
be displayed as positive values. By selecting the toggle buttgativethe values
of reward rates will be displayed as negative values. The three lis&XiX- “Y-
Axis” and “Z-Axis” contain the possible axis labels:State-", “ <Reward>" and
names of the parameters with more than one value.
In the text widgets under each list, the user may change description of the axis.

If the model has more than one varying parameter, then fixed values must lecdétedche
parameters. This is done by clicking at one of the buttons marked with the pararaete, and
by selecting one or more of the possible values from the “Values” dialog (see Fido&fgult
value is the first value in the list of the possible values. If more than one \@kedected the
parameter gets a variable mode. No more than one parameter may havedhkvaade.

In the Driver menu, a plot program can be selected. By default, the following drivers are
installed:

XGraph Driver for thexgraph program (a freely distributable plot program).

Gnuplot  Driver for thegnuplot program (also freely distributable).

Text Driver for a textual representation of the results; the text is displayed tiseng
UNIX view program.

ACE/GR Driver for the ACE/GR program (a freely distributable plot programyiRN 92].
XGadd  Driver for thexgadd program, which has been developed for the PEPSY tool at
the University of Erlangen-Nurnberg [MT 92].

In the Scalemenu can be specified if the X (or Y) axis should have a linear or a logarithmic
scale. There are four possibilities:

Lin/Lin X axis: linear; Y axis: linear.

Lin/lLog X axis: linear; Y axis: logarithmic.

Log/Lin X axis: logarithmic; Y axis: linear.

Log/Log X axis: logarithmic; Y axis: logarithmic.
In the Mode menu can be chosen between a graphaph) or a bar chartilistogram). The
menusMode andScaledo not apply to th&@ext driver.

The toggle buttorSuppress Odetermines whether strategy changes which always happen at
time O should be suppressed or not. The default is to suppress these strategy changes.
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Fxperiment: Availability
Model: 4processors

Mode: Transient Optimization
Migsion Time: 1000

Parameter Set:
gamma; ---

Ferformance Graph

| I

Save | Cancel |

Figure 18: “Parameter Set” dialog.

The toggle buttorShow Parameter Setdetermines whether a window containing graph in-
formations (see Fig. 18) is shown by pressing the OK button or not. This window is for a
documentation purpose. This information can be saved in a data file by clickihg hutton
Save Then a file name is asked for.

In the text widgeExperiment Namethe inscription of the resulting graph may be changed.

Avall-gamma-less E
Availahility

COA-compare- perfarmance
Capacity-gamma-less
Capacity-or.-Avall.

Impact_of_Cov_aAvail - stationary
sana

sana-test

sin-1000tu-ar- M1
sitm-1000t0-nr- M4 —
tana

tana-10-tu

tana-10-tu-1sw-ar

tana-10-tu-1sw-nr ;
Cancel |

Figure 19: “Which Experiment” dialog.

:09 |
gamma: 5e-05

0K

Cancel |

Figure 20: “Dif.Exp.Parameter” dialog.

The toggle buttoifference graph determines whether the resulting graph a difference graph
IS or not.

The choices in th®iff. after menu:

Param. By clicking at one of the buttons marked with the parameter name the “Dif-
ference Values” dialog will appear (see Fig. 17). Select one value from the
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list labeledA, and one or more values from the list labe®dThe toggle
buttonsA-B andB-A determine the subtrahend and minuend. The result
lines are created as the difference between any two lines with the sam
name.

Rewards Choose exactly two rewards which the difference line is made from.

Experiments By clicking at this button the “Which Experiment” dialog (see Fig. 19) with
a list of all possible experiments for this model appears. Choose one of the
experiments and then press OK. If the selected experiment contains more
than one varying parameter the “Dif.Exp.Parameter” dialog (see Fig. 20)
pops up. By clicking at one of the buttons marked with the parameter name
select a fixed value for each parameter. The result lines are craatbeé
difference between any two lines with the same name. The subtrahend
lines belong to the current experiment, the minuend lines belong to the
experiment selected in the “Which Experiment” dialog.

The Rewards menu specifies if the reward axis has nhominal schllenfinal) or normalized
(Time averags.

The choices in th&/hich menu:

all The runs of all reward/strategy lines are displayed.
part Choose rewards/strategies from the “Which” dialog (see Fig. 17) theirs run should
be displayed.

The choices in th&xperiment menu:

one The results of one experiment (i.e. the current experiment) should be displayed.

more  Choose one or more additional experiments from the “Experiments” dialog; the
reward or strategy functions of the additional experiments will be displayed, togethe
with the reward or strategy functions of the current experiment.

The toggle buttonAggregated Rewardsdetermines whether the rewards selected in the
“Which” menu are aggregated or not.

Meaning of the buttons:

OK Displays the graph (see Fig. 21).

Forward Runs the experiment in another interval (see Sec. 2.9.1).

Change The user can change explicitly the result lines of a strategy graph (see
Sec. 2.9.2).

Cancel Leaves the graph parameters dialog.

23



Close [[Hardcopy || &bout Exp.1 (4KI‘IO1‘EI‘I)

Time
200.00: MNZ-=Rz
M3-=R4

180.00

160.00

140.00

120.00

|

|

100.00: ]

a0.00 \
60.00 \
40.00 \

20,00 \\“\o_____ —
gamma = 1073
0.00 10.00 20,00 30.00 40.00 S0.00

Figure 21: A plot program displaying a strategy.
In the graph, strategies are labeled\axle1->Node?2 , which means that the reconfiguration
edge starting ilNode1 and ending ilNode2 is active.

A nodeNthat appears in a macro namigds designated//N. Node names such &/M/M/N
will automatically be abbreviated td"3/N .

If one of the varying parameters has a variable mode the line labels in the grajpimaciret
value of this parameter in parentheses.

If the “Experiments” menu is set to “more” the line labels in the graph cordgamumber in
parentheses that determines which experiment the lines belong to. The laliwlatvetich
number determine lines from the current experiment.

2.9.1 The Forward Experiment Dialog

[¢] Forward Experiment

Farameter: delta
M Equidistant Values:
Interval <0.01, 0.05=

Start Value: & Backwards: 0

® Forwards: 0.06

Step Width: 0.01

Number of steps: |

I Run | e | twwte || cancel |

Figure 22: Forward Experiment dialog for equidistant mode.
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[¢] Forward Experiment
Farameter. gamma

Walues: ED.D1

0.00m
0.000m

Mew Values: [+

Run | | | Cancel|

Figure 23: Forward Experiment dialog for multiple mode.

There are three different forward experiment dialogs depending on the paramater m

(equidistant, log. equidistant or multiple values) of the parameter selattaoki of the axis
lists.

Equidistant Mode The “Forward Experiment” dialog appears (see Fig. 22). The first three
lines give an information about the selected parameter (name, mode, analinter

of values) where the experiment had already run. Active one of the following radio
buttons:

Backwards: value The parameter values are taken from the set
{zlr=a—s-4, 1=0...N =1}

whereaq is theStart Value, s is the Step Width and N Number of Steps
TheValueis the first possible parameter value(). If value< 0 the radio

button is made unvisible. The value in fidldimber of Stepsis accepted if
N > 1andz > 0 for:=N — 1.

Forwards: value The valueis the start value for the new interval. The value in
field Number of Stepsis accepted ifV > 1.

Logarithmic Equidistant Mode The “Forward Experiment” dialog appears. The informa-
tions in the first three lines is equal to the Forward Experiment dialog in thelisgui
tant mode. If the “Backwards” radio button is selected the parametersvalge
taken from the set

{zlz =a/f', i=0...N—1}

whereaq is the Start Value, f is theFactor and /V is theNumber of Steps The
value in fieldNumber of Stepsis accepted itV > 1.

Multiple Mode The “Forward Experiment” dialog appears (see Fig. 23). There are two text
widgets. In the upper one, there are values which the experiment had already run
for. This text widget is not editable. In the second one, new values may be inserted.
At least two values have to be inserted. Each number must be in a sepagate li

Press the buttoRun to run the experiment for the new values. Then the “Forward Experiment”
and “Graph Parameters” dialog disappears and a “Working...” dialog (sed&igs shown.
After the experiment is performed the new results can be seen in the “Gaagimeters” dialog
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(see Sec. 2.9). Now, if the button “Forward” is pressed the new resultsegrined with the
previous by clicking at the buttodoin in the “Forward Experiment” dialog, or they can be
deleted by clicking at the buttdDelete To exit the “Forward Experiment” dialog the button
Cancelmust be pressed.

2.9.2 Change Graph Dialog

e i uuDuU?B 5746
Ne-tiz 0.0008 4716
vooT 3809
vo01a z77E
vz 1917
vms 98

v ez2

Ok Cancel

Figure 24: “Change Graph” and “Change Lines” dialog.

The user has a possibility to change interactively the course of strategynlitiesresult graph.
The “Change Graph” dialog (see Fig. 24) is a list of all strategies in the expetinselect a
strategy its line should be changed. By clicking at the bu@éh the “Change Lines” dialog
(see Fig. 24) appears.

Press the butto@ancelto leave the change graph dialog.

Change Lines Dialog The Change Lines Dialog contains an editable text widget. Each curve
in the graph is represented by a co-ordinate set in the text widget. The usehamgedhis co-
ordinates. Each line must be terminated with new line character. Bewvegy two co-ordinate
sets is an empty line.

Press the butto®K to change the graph. To leave the Change Lines dialog without any change
is done click at the butto@ancel

By clicking at the button Save in the Experiment Editor all changes are saved.

2.10 Resources

Some attributes of XPenelope can be customized by the user. In order to dothes must
be made in the file

$HOME/. Xdefaults

and subsequently the X server must be restarted or the command
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xrdb -load $HOME/.Xdefaults

must be executed.

Here is a list of the customizable resources, their default values, amarteaning:

XPen.geometry: +100+100

Position of the model index after invocation.

XPen.background: Gray90

Background color.

XPen.foreground: Black

Foreground color.

XPen.printCommand: Ipr -P%s

Command to print a file%sis a placeholder for the file name anuist appear in
the resource string.

XPen.PrinterName.value: psr0

Default printer name.

XPen.plotDrivers: '\
XGraph,xgraph.driver,LB \n\
Text,text.driver, XY

Available plot drivers.

TheplotDrivers resource contains an arbitrary number of driver specifications. Each spe-
cification is separated by a newline character. A specification has theatjéarenat

Title, Driver, Capabilities

whereTitle is the text that appears in tlgiver menu of the graph parameters dial@giver is
the name of the program which will be called to display the dagpabilitiesis a string which
contains any of the following characters:

L  Thedriver is able to display logarithmically scaled axes.

B  The driver is able to display barcharts.
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X The driver is able to display alphanumerical strings as tick labels on thesX axi

Y  The driver is able to display alphanumerical strings as tick labels on thesy axi

Several arguments are passed to the driver program:

$1
$2
$3
$4

Name of input file.
Title.
Name of X-axis.

Name of Y-axis.

Additionally, the following options may be passed to the driver:

—xalpha Alphanumerical tick labels on the X axis.

—yalpha Alphanumerical tick labels on the Y axis.

—logx

—logy

—bar

Logarithmically scaled X axis.
Logarithmically scaled Y axis.

Display bar chart instead of graph.

The input file contains XY-pairs, one for each line. The X and Y values are sepalat
one space character. The XY-pairs are grouped by their Z value; a line indidag¢ingvalue
precedes the corresponding XY-pairs; this line starts with the charatter “:

Example:

‘N1->N1
0.1 10
0.2 30
0.4 60
‘N1->N2
0.1 15
0.2 40
0.4 80

This file stands for the XYZ-pairs (0.1,10,N4N1), (0.2,30,N1>N1), ..., (0.4,80,N1>N2).
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3 Examples

This section contains two step-by-step examples which show how to creatsentbdels and
macros with XPenelope.

3.1 Examplel

2
y Cov

1-c

Figure 25: A simple model (frorDEME 92, p. 52])

The first example shows how to create the model depicted in figure 25. The follosviragd
rates shall be assigned to the states:

| State | Reward rate |
NO 0
N1
R1
N2
RB
RC
Cov

O OOk Kk

Phase 1: Create the states

Step 1: Invoke XPenelope by entering the command
xpenelope

on the command line. After a few seconds, the model index should appear on the
screen.

Step 2: Press the&Create button in order to create a new model.
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Step 3: Select the itemMarkov State from the Edit menu. This activates thiglarkov
state modgin this mode, every mouse click in the drawing area produces a new
Markov state.

Step 4: For every Markov state in figure 25, click the left mouse button at the correspond-
ing position in the drawing area. For every mouse click, a circle with a murest
mark appears on the screen.

Step 5: Select the itenBranch State from the Edit menu. This activates thBranch
state modgin this mode, every mouse click in the drawing area produces a new
branching state.

Step 6: Make one mouse click in the drawing area in order to create theGtateThe
drawing area should now look like figure 26.

Figure 26: Model editor containing six Markov states and one branching state

Phase 2: Assign names and rewards to the states

Step 7: Select the itenBet Parametersfrom theEdit menu. This activates th®et pa-
rameters moden this mode you may click at any object in order to modify its
parameters.

Step 8: The question marks displayed on top of each state signal that the parameters for
the states have not yet been entered. Thus, click at the Nfafethe leftmost
state). The “Parameters...” dialog appears. Enter the node name “N2"fielthe
Name enter the reward rate “1” in the fieReward. Press th©K button.

Step 9: Repeat step 8 for each state.
Phase 3: Create the transitions and reconfiguration edges

Step 10:  Select the itemlransition from the Edit menu. This activates th&ansition
mode in this mode, you may click at two states in order to create a transition
between these states.
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Step 11:

Step 12:

Step 13:

Step 14:

First, we will create the transition between stht2and stateCov: click at state
N2, then at stat€ov. A transition with a question mark on top of it appears.

Repeat step 11 for each transition. If you create the transition Rarto N2,

you probably don’t want to connect the states by a straight line. Therefore, you
may proceed like this: click at staRl, then click somewhere between st&e
andN2, and finally click at stat&2. This will produce a transition consisting of
two line segments.

Select the itenReconfiguration Edgefrom the Edit menu. This activates the
Reconfiguration edge mogdae this mode, you may click at two states in order to
create a reconfiguration edge between these states.

The example model contains only the reconfiguration edge betweemN4tated
R1. Thus, first click at stat®1 and then at stat®1. A reconfiguration edge
between the two states appears. The drawing area should now look like figure 27.

Figure 27: States and transitions.

Phase 4: Assign transition rates and probabilities to the edges

Step 15:
Step 16:

Step 17:
Step 18:

Select the itenbet Parametersfrom theEdit menu.

Click at the transition between stat@ and stat€Cov. The “Parameters...” dialog
appears.

Enter the transition rate “2 * gamma” in the fidRhte. Press th®©K button.

Repeat step 17 for each transition. If you click at a transition originating i
branching state, the “Parameters...” dialog will contain a figdobability . In
this field you have to enter the probability of the transition (“c” or “1-c” in our
example). The drawing area should now look like figure 28.
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Figure 28: The completed model.

Phase 5: Save the model

Step 19:  Select the itenbavefrom theFile menu. A dialog appears which prompts you
for a model name. Enter “SimpleExample” and pressQiebutton.

Step 20: A message dialog with the text “Model saved” appears. PresSkhbutton.

Phase 6: Create a parameter set
We will now assign concrete values to the individual model parameters. Thesvale will

choose are:

| Model parameter | Value(s) |

alpha 0.01
beta 0.1
c 0.99
delta 0.01
gamma 1075,
1074,

1073,

1072,

107!

Step 21:  Select the item “SimpleExample” in the model editor and pres©ien button.
A pop-up menu appears; select the it®arameter Index... The parameter

index appears.

Step 22:  Press th€reate button of the parameter index in order to create a new parameter
set. The parameter set editor shown in figure 29 appears.
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Figure 29: The parameter set editor.

Step 23:  Click at the item “alpha” and enter the value “0.01” in the fishlue.
Step 24:  Repeat step 23 for the parameters “beta”, “c” and “delta”.

Step 25:  Select the item “gamma” and press the buthdirbitrary Values . Now enter
the values “1e-5", “le-4", “1e-3”, “le-2” and “le-1" in the fieMalues one
value per line.

Step 26:  Press th&avebutton.

Step 27: A dialog appears prompting you for the “Parameter Set Name”. Enter “PSet”
and press th®K button. A message dialog with the text “Parameter Set Saved”
appears; press ti@K button.

Phase 7: Create the experiment definition

Step 28:  Select the item “SimpleExample” in the model editor and pres©ien button.
A pop-up menu appears; select the itBxperiment Index.... The experiment
index appears.

Step 29:  Press the&Create button of the experiment index in order to create a new experi-
ment definition.

Step 30: A dialog appears prompting you for the “Experiment Name”. Enter “Exp” and
press theéOK button. The experiment editor appears.
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Step 31:

Step 32:
Step 33:
Step 34:

Press the buttoRarameter Set which currently has the labé??. The “Para-
meter Sets” dialog appears, which shows a list of the available panasette
Currently only the parameter set “PSet” is available. Select thiswpetex set
and press th®K button. The label of th@arameter Setbutton has changed to
“PSet” to reflect the currently selected parameter set.

Enter the value “500” in the fielMission Time.
Enter the value “0.1” in the fiel&tep Width.

Make sure that the radio button label&@nsient Optimization is active.

Phase 8: Start the experiment

Step 35:

Step 36:

Press thdRun button. The “Working...” dialog appears. Wait until this dialog
disappears from the screen. Then the experiment has finished.

Press the&Savebutton. A message dialog with the text “Experiment Saved” ap-
pears; press th@K button.

Phase 9: Show the results

Step 37:
Step 38:
Step 39:

Step 40:

Step 41:

Step 42:
Step 43:

Step 44:
Step 45:

Step 46:

Press th&Showbutton. The “Graph Parameters” dialog appears.
Make sure that the program “XGraph” has been selected iDtiver menu.

Select the itenLog/Lin from the Scalemenu in order to scale the X-axis loga-
rithmically.

Press th@®©K button. After a few seconds, the graph shown in figure 30 appears.

Interpret the results: The curve labeleN1*-~R1" indicates that above this
curve the reconfiguration edge from stié to stateR1 is active. E.g. for
gamma = 0.001 the reconfiguration edge is active from the start of the mission
until 41.8 time units before the end of the mission.

Remove the graph window by pressing tiesebutton.

You may now modify the settings of the “Graph Parameters” dialog in order to
modify the appearance of the graph. For example, you might sefélathie>"

from the X-Axis list and “<Strategy-" from the Y-Axis list. If you now press
theOK button, the graph appears with the X- and Y-axes swapped.

Click at the radio buttoPerformance Graphin the “Graph Parameters” dialog.

You may select one or more performance curves by selecting the “part” item in
theWhich menu. The “Which” dialog appears. Select one or more items in the
list of model states and pre€s<.

Press th®©K button in the “Graph Parameters” dialog. A performance graph for
the selecting states appears.
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Figure 31: Model of the Erlang-distribution

The second example shows how to create and use macros. In this example avmabro
models the Erlands-distribution shall be created.

Figure 31 shows the model of the Erlakghistribution: it consists of a chain &fMarkov states
with a transition rate ok-;.. Erlangk distributions are generally used to model non-exponential
distributions with a small variance.

An Erlangk distribution can be thought of as one Markov state which is connected to an Erlang-
k-1 distribution (see figure 32). This means that a model for the Eragligtribution can be
built using a recursive macro.

The macro for the Erlang-distribution is depicted in figure 33. The macro contains a parameter
N, which is incremented by one with each recursion step. The macro invaesiitN<k;
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Figure 33: Macro for the Erlangdistribution

otherwise the macr@onnectis called. Connectis a macro which simply connects the input
with the output. The branching sta®mis needed to connect the outputs of the two macros
with Out, because itisn’'t allowed to connect more than one edge to a macro terminator.

The following paragraphs show how to create the Erlang macro.

Phase 1: Create the Connect macro

Step 1: Invoke XPenelope and press tBesate button of the model index.

Step 2: Select the itenMacro Terminator from theEdit menu. This activates tHdacro
terminator modein this mode, every mouse click in the drawing area produces a
new macro terminator.

Step 3: Click the left mouse button twice in the drawing area in order to produce the
terminatordn andOut

Step 4: Select the itenBet Parametersfrom theEdit menu.
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Step 5:

Step 6:
Step 7:
Step 8:

Step 9:

Click at the first macro terminator. The “Set Parameters...” diajggears. Enter
“In” in the field Nameand press th®K button.

Repeat step 5 for the second macro terminator (hame: “Out”).
Select the itenTransition from theEdit menu.

Click at the terminatoin and then at the terminat@ut A transition between
the two terminators will appear (see figure 34).

:'ﬁD”””'@,":
Figure 34: TheConnectmacro

Select the itenBavefrom the File menu and save the macro under the name
“Connect”.

Phase 2: Create the nodes of the Erlang macro

Step 10:

Step 11:

Step 12:

Step 13:

Step 14:

Create the terminatoia andOut of the Erlang macro as shown in steps 2 to 5.
Create the Markov stat® and the branching sta@mas shown in example 1.

Select the itemMacro from theEdit menu. This activates thdacro mode in
this mode, every mouse click in the drawing area produces a new macro invoca-
tion.

The “Macros” dialog box appears. Select the item “Connect” from the list and
press theOK button.

Click the left mouse button while the cursor is in the drawing area. An iniamta
of the Connectmacro will appear.

Phase 3: Create a forward declaration for the Erlang macro

At this point, we have the problem that we need to use the Erlang macro. This meweyer,
has not yet been defined. Thus, we have to create a forward declaration, whichsrfea
model editor about the names of the macro sockets and the names of the macro pardinete
parameters of the Erlang macro are:

| Parameter | Meaning
k Number of phases
mu Transition rate
N Recursion depth
rew Reward rate
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Step 15:  Select the itenMacro from theEdit menu. The “Macros” dialog box appears.
Step 16:  Press thd-orward... button. The “Forward Declaration” dialog appears.
Step 17:  Enter “Erlang” into theClassfield.

Step 18:  Click at theln button and enter “In” in th&Socket namefield. Then press the
Insert button. This inserts the input socket “In” into tB@cket namedist.

Step 19:  Click at theOut button and enter “Out” in th8ocket namefield. Then press the
Insert button. This inserts the output socket “Out” into thecket namedist.

Step 20:  Enter “k” in the Parameter namefield and press thinsert button. This inserts
the parameter “k” in into th®arameterslist.

Step 21:  Repeat step 20 for the parameters “mu”, “N” and “rew”.
Step 22:  Press th®©K button.

Step 23:  Click the left mouse button while the cursor is in the drawing area. An iniamta
of theErlang macro will appear.

Phase 4: Edit the macro parameters

Step 24:  Select the itenbet Parametersfrom theEdit menu.
Step 25:  Click at the invocation of th€onnectmacro. The “Macro” dialog appears.
Step 26:  Enter the node name “C” in tHgamefield.

Step 27:  Enter the condition “N=k” in th&Condition field. The meaning of this condition
is that this macro must not be invokedkiandN are not equal.

Step 28:  Press th®©K button.

Step 29:  Click at the invocation of th&rlang macro. The “Macro” dialog appears.
Step 30:  Enter the node name “E” in tHdamefield.

Step 31:  Enter the condition “Nck” in the Condition field.

Step 32:  Change the content of the fied from “N” to “N+1”. This means thatN is
incremented with each recursion step.

Step 33:  Press th®©K button.

Phase 5: Complete the macro definition

Step 34:  Select the itenTransition from theEdit menu.

Step 35:  Create all necessary transitions as shown in figure 33.
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Figure 35: Theerlang macro

Step 36:  Save the macro under the name “Erlang”. It is important that this name is the
same as the name that has been specified in the forward declaration dialog. The
completed macro definition should look like figure 35.

Phase 6: Use the Erlang macro

Step 37:  Select the itenMacro from theEdit menu. The “Macros” dialog appears.
Step 38:  Select the item “Erlang” from the list and press K button.

Step 39:  Click the left mouse button while the cursor is in the drawing area. An iniamta
of theErlang macro appears.

Step 40:  Select the itenBet Parametersfrom theEdit menu.

Step 41:  Click at the macro invocation. The “Macro” dialog appears.

Step42: Enter a node name.

Step 43:  Enter the value “1” in the fieltNl in order to initialize the recursion depth counter.
Step 44:  Modify the parameters “mu”, “rew” and “k” to suit your application.

Step 45:  Build your model around this macro invocation. An example is shown in fig-
ure 36.

4 Conclusion

The combination of the tools Penelope and XPenelope enables a fast and comforttiga cre
and optimization of extended Markov reward models.
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Figure 36: A simple model with an invocation of tBelang macro

Penelope contains algorithms for the analysis and optimization of staticallgyaramically
reconfigurable systems. XPenelope supports the model creation, the experiment nemagem
and the visualization of the results. The macro mechanism of XPenelope makssilile to

split large models into smaller and simpler submodels.

The user-friendly X window interface, the operating system independent datpbasanently
executed consistency checks, and many other features make XPenelopetite weosking
environment for the modeling and optimization of reconfigurable systems. Many atjpmtic
examples can be found imEME 94].
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